Lecture 9
Why are we learning Excel?
Why Learn Excel?
· Excel is the most popular spreadsheet tool today.
· Excel has been regarded as the true “killer app” by many experts.
· You probably already use or will soon be using Excel at work, and possibly at home.
· Excel can be used for simple data management and problem-solving, as well as complex decision making
· From a learning standpoint: excel can be used to cultivate Critical Thinking and Decision Making Skills
[image: ]Based on Robert Reich (former US Secretary of Labour):
· Four Skills required for future job roles: 
· A good information Systems education is comprehensive across these skills
Introduction to Microsoft Excel
Microsoft Office Excel 2010 (Excel):
· A computer program used to enter, analyze, and present (quantitative) data
·  A spreadsheet program
· A spreadsheet is a collection of text and numbers laid out in a rectangular grid.
· Often used in business for accounting, budgeting, financial analysis, inventory management and other functions.
An electronic spreadsheet program such as Excel aids a multitude of problem-solving & decision-making processes through providing:
· data management features 
· automatic calculation functions
· presentation tools
· decision analysis functions
Worksheets and Workbooks
Excel
· a computerized spreadsheet application used to build and manipulate worksheets and workbooks
Worksheet
· a spreadsheet that may contain data including text, numbers, formulas, charts etc.
· Sometimes a charts based worksheet is referred to as a “Chartsheet”
Workbook
· a collection of related worksheets within one file
Basic Components of the Excel Interface

File Tab:
· Consists of file operations commands such as opening, closing, saving, printing, and sharing files.
· The options and features available here are part of the “Backstage view”
Tabs & Ribbon:
· Each tab corresponds to sets of features displayed horizontally as a ribbon.
· A ribbon consists of groupings, and controls.
· Tabs are designed to be task-oriented and consist of several logical groupings of controls that perform similar functions.
Quick Access Toolbar:
· Contains controls / commands that are most commonly used. Additional controls can be added through Excel Options settings through the Office Button.
Select All Button:
· Used to select all elements of the worksheet.
Status Bar:
· Displays information about a selected command or operation in progress.
· Also displays basic summary information about a selected range of values.
HANDY HACK
· You can customize the status bar to show the types of summary information you are interested in.
· Just right-click the status bar and select the options you wish to use.
Planning for Good Workbook and Worksheet Design
Plan before you start entering data
· Decide on the purpose of the spreadsheet and how it will be constructed
· Make it obvious where data is to be entered:
· Use titles, headings, instructions, color schemes, and forms to designate areas for data-entry.
· Wherever possible, setup formulas and use cell references for calculations
· Allow Excel to do what it was designed for, i.e., automatic calculations
· Try to minimize hard-coded numbers in your calculations.
Test multiple times to make sure the results are what you expect:
· Check your results against your mental model of what the results should be.
Format the worksheet so it looks aesthetically pleasing.
Document the worksheet as thoroughly as possible:
· Provide summaries or comments in a separate worksheet including ranges being used for calculations and analysis.
Save your work regularly:
· Modify the default save intervals if necessary.
Cells, Ranges, and References
Each cell is referenced by its intersecting column (letter) and row (number):
· e.g. cell A1 is the topmost left cell in the spreadsheet.
· The cell reference is shown in the name box beside the formula bar.
A range is a rectangular group of cells in a worksheet:
· can be one single cell or may be entire worksheet.
Selecting a range:
· Click and hold left mouse button and drag from beginning of range to end
· Select first cell, then hold the Shift key while clicking the last cell
Can consist of contiguous (together) or non-contiguous (not together) cells:
· Hold the Ctrl key to select non-contiguous ranges.
A contiguous range of cells is referenced by the top left cell reference and the bottom right cell reference:
· e.g. B2:D5
Entering & Editing Data
Entering Data in Cells:
· Text, Numbers, Formulas can be entered either directly in each cell or through the formula bar.
Editing Data in Cells:
· Data in cells can be modified using one of three ways:
· Selecting the cell you want to edit, clicking the Formula Bar, making changes, pressing Enter or the Check symbol. 
· Double clicking the cell to be edited, making the changes, pressing Enter 
· Selecting the cell, pressing the F2 key, making the changes, pressing Enter 
Auto-Fill Feature:
· Used to repetitively copy contents of one cell or a range of cells.
· Used to complete a sequence, pattern or lists like numbers, increments, months 
· Enables you to copy or continue the content of a cell or a range of cells to its adjacent cells (below or to the right).
· Select a cell or range of cells to be copied or continued,
· Drag the “fill handle” over an adjacent cell or range of cells 
· The fill handle is a small black square appearing in the bottom-right corner of a cell
HANDY HACK:
· You can define your own custom lists in Excel to give more power to the Auto-Fill feature.
· Use the Excel Options control in the backstage view and look under Advanced  Edit Custom Lists.
Using Formulas
Formulas are used to perform operations and arrive at a calculated result.
· A formula is an expression that returns a value through performing operations on literal values specified in the formula itself or referenced values from other cells
Must begin with an equals (=) sign.
Formulas mostly contain mathematical operators.
Used to automate calculations that were once done manually.
Rather than typing a cell address, use an alternative method that involves minimal typing:
· Pointing uses the mouse or arrow keys to select the cell directly when creating a formula.
Auto-Fill feature can also be used to duplicate formulas:
· Formula references are updated according to the target cell for the formula results.
What are they?
· A formula is an expression that returns a value through performing operations on literal values specified in the formula itself or referenced values from other cells
· The most commonly used operators are arithmetic operators
Complex Formulas:
· Formulas follow “order of precedence”     (BEDMAS)
· A set of predefined rules used to determine the sequence in which operators are applied in a calculation
Copying and Pasting Formulas
· With formulas, Excel adjusts the formula’s cell references to reflect the new location of the formula in the worksheet
To view formulas in a workbook, switch to formula view:
· press the Ctrl and ~ keys
· A view of the workbook contents that displays formulas instead of the resulting values
Using Functions
What are they?
· A function is a named operation (predefined formula) that returns a value.
· A function take values (literal values or referenced values), performs operations, and returns results:
· The values are passed to the function as parameters enclosed in brackets.
· For example, to add the values in the range A1:A5, 
You could enter the following long formula:
=A1+A2+A3+A4+A5
OR
You could use the SUM function to accomplish the same thing by entering:
=SUM(A1,A2,A3,A4,A5)
=SUM(A1:A5)
Creating Effective Formulas:
· Do not embed important data in a formula (rather, put that data in a separate cell)
· Using referenced values is better than using literal values
· This prevents hiding important data
· This prevents easily changing important data without the need to edit formulas
· Keep formulas simple
· Sometimes it’s useful to break formulas into intermediate results
Ranges and Excel Tables
A range of cells with column headings (arranged as a flat table) is a good starting point for analysis of data in the range.
An Excel Table can enhance the presentation and facilitate sorting and filtering of data in the ranges.
Steps to Convert a Range into an Excel Table:
· Make sure the range is arranged as a flat table with column headings.
· Click anywhere inside the range, and click the Table button in the Insert tab.
· Dropdown handles with every column heading allow the use of sorting and filtering functions.
Steps to Convert an Excel Table back into a Range:
· Click anywhere in the excel table.
· Select: Table Tools  Design  Convert to Range (Table Tools) 
Sorting and Filtering
· Sort data in ascending or descending order
· Filter data to display the portion that meets the criteria specified
· Data can be sorted or filtered by selecting the sorting arrow filtering arrow.
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Lecture 10
Relative & Absolute Cell References
Relative Cell References:
· Cell addresses that are adjusted as a formula containing these addresses is copied within the spreadsheet
· Used by default in most spreadsheet calculations 
· e.g. B6 copied over two columns to the right will become D6
· e.g. K12 copied over one column to the left and one row above will become J11
Absolute Cell References:
· Cell addresses that stay fixed & are not adjusted as a formula is copied 
· Used when the formulas should always use the value in a particular cell
· Used for constant values (e.g. sales tax rate etc.) 
· e.g. $B$6
Mixed Cell References:
· Cell addresses where either the row or the column is fixed
· e.g. $B6 refers to a cell address where the column is fixed to B but the row can increase or decrease as the formula is copied vertically
· e.g. J$11 refers to a cell address where the column can vary as the formula is copied horizontally but the row is fixed to 11.
Data Delivery Functions in Excel
Data Delivery functions do not perform calculations per say:
· These functions can be used to verify data, search for data, transform data or deliver data from one point to another.
e.g. Filter Unique Values:
· Used to filter and deliver unique values from a list
e.g. Data Validation & Drop-Down Menus:
· Used to allow end-users to select from a predefined lists of values
e.g. Lookup Functions:
· Used to retrieve values from tables based on lookup values
Using Lookup Tables and Functions
A lookup table is a table that organizes data you want to retrieve into different categories
The categories for the lookup table, called compare values, are located in the table’s first column or row
To retrieve a particular value from the table, a lookup value (the value you are trying to find) needs to match the compare values
· =VLOOKUP(lookup_value,table_array,col_index_num[,range_lookup])
· =HLOOKUP(lookup_value,table_array,row_index_num[,range_lookup])
· The last parameter (shown in square brackets) is optional:
· By default, it is assumed that you need a closest match to the compare value
· Set this parameter to FALSE if you need an exact match to the compare value.
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More Examples of Functions:
Statistical Functions
· =AVERAGE(number1,number2,..)
· Excel sums the values in the range and then divides by the number of non-blank cells in the range
· =STDEV(number1,number2,..)
· =MAX(number1,number2,..)
· =MEDIAN(number1,number2,..)
· =PEARSON(number1,number2,..)
· Pearson correlation coefficient
Counting Functions
· =COUNT(range)
· Counts the number of cells that contains numbers
· =COUNTA(range)
· Counts the number of cells that are not empty
· Both numeric and text entries are included
· =COUNTBLANK(range)
· Counts the number of empty cells
· =COUNTIF(range,criteria)
· Counts the number of cells within a range that meets the condition
Summarizing Data Through Subtotals & Grouping
Subtotals:
· Excel provides a number of features that enable you to organize large groups of data into more manageable groups. 
· Data in a list can be summarized by inserting a subtotal.
· Before you can subtotal, however, you must first sort the list by the field on which you want the list subtotaled.
Grouping:
· If you have a list of data that you want to group and summarize, you can create an outline. 
· Grouping refers to organizing data so that it can be viewed as a collapsible and expandable outline. 
· To group data, each column must have a label in the first row and the column must contain similar facts. The data must be sorted by the column or columns for that group.
Problem-Solving & Modeling Process
Phases in Problem-Solving & Modeling Process:
· Formulation
· Transformation of a real problem scenario into a mathematical model
· Solution
· Solving the model to obtain the optimal solution
· Interpretation
· Analyzing results and implementing solution
Modeling Approach to Problem-Solving
Models are usually simplified versions of the things they represent:
· a valid model accurately represents the relevant characteristics of the object or decision being studied
Types of models:
· Mental (e.g. arranging furniture)
· Visual (e.g. blueprints, road maps)
· Physical/Scale (e.g. aerodynamics, buildings)
· Mathematical (e.g. financial analysis) 
A Computer Model:
· A set of mathematical relationships and logical assumptions implemented in a computer as an abstract representation of a real-world object or phenomenon.
· Spreadsheets provide the most convenient way for business people to build computer models.
Benefits of the Modeling Approach:
· Economy:
· It is often less costly to analyze decision problems using models.
· Timeliness:
· Models often deliver needed information more quickly than their real-world counterparts.
· Feasibility:
· Models can be used to do things that would be impossible.
· Models give us insight & understanding that improves decision making.
Example of a Mathematical Model:
· Specifically:
Profit = Revenue – Expenses
Or
Profit = f (Revenue, Expenses)
Or
Y = f (X1, X2)
· Generically:
Y =    f(X1, X2, …, Xn)
Y =    dependent variable 
Xi = independent variables (inputs having an impact on Y)
f(.) = function defining the relationship between the Xi & Y
· Most spreadsheet models are very similar to the generic mathematical model:
=    f(X1, X2, …, Xn)
· Most spreadsheets have input cells (representing Xi) to which mathematical functions ( f(.))  are applied to compute an output variable (or Y).
Examples of Functions
Financial/Annuity Functions
· An annuity is a series of constant cash payments made over a continuous period
· A car loan or a mortgage is an annuity
· Benefits received each period is an annuity
· Cash you pay out is represented by a negative number; cash you receive is represented by a positive number 
· A $1,000 deposit to the bank would be represented by the argument -1000 if you are the depositor 
· A $1,000 deposit to the bank would be represented by +1000 if you are the bank
Future Value Function:
Syntax
· =FV(rate,nper,pmt,pv,type)
· Rate    
· Interest rate per period – e.g. 8 percent annual interest rate
· Nper
· Total number of payment periods in an annuity – e.g. 10 years
· Enter 10 into the formula for nper
· Pmt    
· Payment made each period
· Cannot change over the life of the annuity 
· Pv
· (optional) present value or the lump-sum amount that a series of future payments is worth right now
· Type
· (optional) the number 0 or 1 indicates when payments are due. If type is omitted, it is assumed to be 0 (end of period)
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Formula Auditing
Show Formulas
· In the Formula Auditing group, click Show Formulas
· Alternatively, you can use the following key
combination: Hold Ctrl & Press ~
Trace cells that provide data to a formula (precedents)
· Select the cell that contains the formula for which you want to find precedent cells.
· To display a tracer arrow to each cell that directly provides data to the active cell, on the Formulas tab, in the Formula Auditing group, click Trace Precedents
Trace formulas that reference a particular cell (dependents)
· Select the cell for which you want to identify the dependent cells.
· To display a tracer arrow to each cell that is dependent on the active cell, on the Formulas tab, in the Formula Auditing group, click Trace Dependents
	
	States of Nature

	Alternatives
	Low Demand
	Medium Demand
	High Demand

	
	0.10
	0.50
	0.40

	Decision A
(Small Plant)
	20,000
	40,000
	60,000

	Decision B
(Medium Plant)
	30,000
	50,000
	90,000

	Decision C
(Large Plant)
	-120,000
	25,000
	200,000


Data Modeling Example: Decision Heuristics
Heuristics:
· Heuristic methods are used to speed up the process of finding a good enough solution, where an exhaustive search or advanced problem-solving techniques are impractical. 
· a "rule of thumb“
· an educated guess
· an intuitive judgment
· or common sense.
· The most fundamental heuristic is trial and error.
· Other examples of heuristics:
· Maximax method
· Maximin method
· Averaging method
· Expected Monetary Value (EMV)
Illustrated Example
· The management estimates the profits when choosing from the three alternatives
(A, B, and C) under the differing probable levels of demand.
· These profits, are presented in the payoff table below: 
· Potential Heuristics for Alternative Selection:
· Maximax
· Maximin
· Averaging (Equally Likely)
· Additionally, the management estimates probabilities of different states of nature based on the latest economic outlook reports.
· Heuristics based on Probability Information:
· Expected Monetary Value (EMV)
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Excel Efficiency Tips
Excel Efficiency Tip 1:
· Use the Help Engine to get full help and tutorials for Excel Functions that you might be stuck with.
· Type the function name, open parenthesis and then click on the name of the function in the tooltip.
· Use the function dialog box to enter the parameters:
· Search for the function under the “Formulas” tab, or
· In the formula bar, type the name of the function and press Ctrl+A
Excel Efficiency Tip 2:
· When performing a Copy-Paste of data in a worksheet, use “Paste-Special” to:
· Paste Values Only
· Transpose Columns of data into Rows and vice versa.
Logical & Conditional Functions
Logical Tests:
· Result of these functions is a logical value (TRUE or FALSE).
· Examples:
· Comparison operators that can be used in logical tests are:
· Equals = ; Less than <  ; Less than or equal to  <=  ; Greater than  >  ;
Greater than or equal to  >=  ; Not equal to  < >
· Other Logical Functions:
AND
OR
NOT
Conditional Functions:
· Result may be a specified value or a calculated value.
· Examples:
IF
COUNTIF
SUMIF
AVERAGEIF
COUNTIFS, SUMIFS, AVERAGEIFS (to be used when multiple criteria are to be tested)
Logical Functions:
· AND Function
· Allows you to test the condition of more than just one criterion (condition).
· Returns either TRUE or FALSE.
· Only returns TRUE if all tested values are TRUE
· AND (logical1 [,logical2]…)
Example: =AND(G2="FT",M2>=1)
· OR Function
· The OR function is a logical function that returns a TRUE value if any of the logical conditions are true and a FALSE value if all the logical conditions are false
OR (logical1 [,logical2]…)
Example: =OR(G2="FT",M2>=1)
· NOT Function:
· Reverses the value of its argument.
· Used when you want to make sure a value is not equal to one particular value.
Example: =NOT(G2=“Blah”)
Conditional Functions
· IF Function
· Evaluates whether a condition or a logical test is true or false and returns one value if the condition is true, and another value if the condition is false.
· If true then value “a” else value “b”
· IF(logical_test, value_if_true, [value_if_false])
· Example: IF(A2=“Yes”,B2*C2,0)
Nested IF Functions
· A nested IF function is when one IF function is placed inside another IF function to test an additional condition
· The Number of IF functions in total would be one less than the number of possible outputs.

=IF(D2=1,2%,IF(D2=2,3%, IF(D2=3,4%,"Invalid Pay Grade”)))
· Read this as follows:
· If the value in D2 is equal to 1, then result is 2%
· Else… If the value in D2 is equal to 2, then result is 3%
· Else… If the value in D2 is equal to 3, then result is 4%
· Else… result is “Invalid Pay Grade”
· Summary Functions: COUNTIF, SUMIF, AVERAGEIF
· You can calculate the number of cells in a range that match criteria you specify using the COUNTIF function, i.e. a conditional count: =COUNTIF(range,criteria)
· You can add the values in a range that meet criteria you specify using the SUMIF function, i.e. a conditional sum: =SUMIF(range,criteria[,sum_range])
· You use the AVERAGEIF function to calculate the average of values in a range that meet criteria you specify, i.e. a conditional average: =AVERAGEIF(range,criteria[,average_range])
· The COUNTIF, SUMIF, and AVERAGEIF functions specify only one condition to summarize the data.
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Excel as a Front-End Tool for Business Intelligence
Business Intelligence:
· A broad category of applications and technologies for gathering, storing, analyzing, sharing and providing access to data to help enterprise users make better business decisions
· BI applications are decision support tools that enable real-time, interactive access, analysis and manipulation of mission-critical corporate information.
· Components (R-A-D)
· Reporting 
· Regular Mass Information Dissemination in a standard format
· Analytics 
· Slicing and Dicing with visual feedback and interactivity. 
· Mainly for the Middle Management – for Tactical Decisions and to guide Strategic Decisions
· Dashboards 
· Quick Distilled Snapshots, highlighting the key Indices, for Instant Decision Making
Dashboards:
· (Example) Car Context:
· A panel extending across interior of a vehicle, usually containing instruments and controls
· BI Context:
· A visual display of the most important information needed to achieve business objectives – consolidated and arranged on a single screen so the information can be monitored at a glance
Key Ideas:
· More than just Data (Data  Information)
· Visual tool with graphical displays of key performance indicators (KPIs)
· Information is organized and presented in a way that is easy to read and interpret (at a glance)
Types of BI Dashboards:
· Strategic Dashboards:
· provide quick overview that decision makers need for monitoring the health and opportunities of the business
· typically derived from static snapshots of data, and focus on high-level measures of performance:
· comparisons with targets or levels
· performance indicated categorically or on scales (good/bad ; high/medium/low)
· Analytical Dashboards:
· support more sophisticated data analysis by facilitating rich comparisons, and fine grained performance evaluation (drill-down ; slice-and-dice)
· used to not only see what is going on, but to examine the causes
· Operational Dashboards:
· for monitoring operations in real-time
· uses simple display media to quickly identify and understand events and to ensure timely responses
· Excel is a practical and easy-to-use front-end tool for strategic dashboards.
Dashboard Visualization and Display Media:
· Summarized and Highlighted Text:
· Calculated Data & Summary Metrics
· Conditionally Formatted DataConditional Formatting
Controls in Excel 

· Icons:
· Alerts
· Up/down
· On/off
· Graphs & Charts:
· Column & Bar Charts including Clustered and Stacked Bar ChartsCharts
Controls in Excel 

· Line Charts
· Pie Charts
· Bubble Charts
· Combination of the above
· Sparklines & Tiny In-Cell Charts
· Built-in tools in Excel 2010
· Add-ins / Workarounds available for Excel 2007
Graphs & Charts
· A Chart is a graphic or visual representation of data
· Charts provide a means to enhance information, adding visual appeal and making it easy to analyze data
· General Guidelines for Creating Charts:
· Select the type of chart that best presents your message:
· See Charts group under the Insert Ribbon. 
· Add enhancements such as titles, legends, and custom colors to better communicate your information:
· See Chart Design and Layouts tabs under Chart Tools (context menu for charts).
Charts Terminology:
· Data points:
· numeric value that describes a single item on a chart:
· Data series:
· groups of related data points
· Category labels:
· describe a group of data points in a chart
· Multiple data series charts can help compare two or more sets of data:
· Clustered column chart 
· [bookmark: _GoBack]Groups similar data in columns 
· Makes visual comparison easier
· Stacked column chart 
· Places (stacks) data in one column with each data series in a different color for each category
Five main steps to creating a chart:
1. Specify the data series:
· The rows and/or columns that contain the data you want to chart
2. Select the range to chart:
· Can be a single cell, but most often is multiple cells
· Cells may be adjacent or non-adjacent
· Use Shift key to select adjacent cells; use Ctrl key to select non-adjacent cells
3. Select the chart type:
· Pick the type that will best visually illustrate the information you want to convey
4. Insert the chart and designate the chart location:
· Insert as an embedded object in the worksheet
· Can print worksheet and chart on one page
· Insert the chart as a New Sheet
· Will require you to print the worksheet and chart on separate pages
· You can choose the location to display the chart
5. Choose chart options/add graphics in charts:
· using the Design, Layout and Format tabs in the Chart Tools context menu
· add company logos or representative clip art to personalize charts
Conditional Formatting
· offers an easy way to apply dynamic formatting to cells based on the values in those or other specified cells.
· e.g. you could apply conditional formatting to a range of cells that contain sales totals, specifying that if any of the totals drops below $10,000, the format of the cell changes to stand out from the other cells.
· Choose Home  Styles  Conditional Formatting:
· Quick Conditional Formatting options:
· Cell Rules: highlights cells with values greater than, lesser than, equal to or between specified values.
· Top/Bottom Rules: highlights top or bottom values according to absolute or percentage thresholds.
· Data Bars: helps you see the value of a cell relative to other cells.
· Color Scales: visual guides that help you understand data distribution and variation.
· Icon Sets: can be used to annotate and classify data into three to five categories separated by a threshold value.
· Rules Manager:
· If your conditional formatting needs are more complex, you can use a logical test formulas to specify the formatting criteria.
· The Rules Manager can be used to view, edit or delete existing Conditional Formatting rules or to create new ones.
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What-If Analysis in Excel
What-If Analysis
· the study of how the uncertainty in the output of a model can be attributed to different sources of uncertainty in the model inputs.
· Using a spreadsheet, what-if analysis involves changing the values in cells to see how those changes will affect the outcome of formulas on the worksheet.
· What-if analysis tools in Excel include:
· Scenarios
· Goal Seek
· Data Tables
Decision Analysis Using Excel’s Goal Seek Feature
What is it?
· Cost-volume-profit (CVP) analysis (sometimes called a break even point analysis) expresses the relationship between a company’s expenses, its volume of business, and the resulting profit or net income
Types of expenses
· Variable expenses change in proportion to the amount of business a company does
· A fixed expense is an expense that must be paid regardless of sales volume
To perform what-if analysis:
· Change the value of a worksheet cell (the input cell)
· Observe its impact on the calculated cells (the result cells)
To perform goal seeking:
· In the Data Tools group on the Data tab, click the What-If Analysis button, and then click Goal Seek
· In the Set cell box, select the result cell, and then, in the To value box, specify its value (goal)
· In the By changing cell box, specify the input cell
· Click the OK button. The value of the input cell changes to set the value of the result cell

· Very useful for doing simple queries to see what the effects are of changing the values of certain variables.
· For complex analyses, one could do several rounds of what-if analyses and run the Goal Seek function in Excel
· However, a more efficient approach is to use a data table
· A data table organizes the results of several what-if analyses within a single table
Decision Analysis Using Solver
· Solver is a separate program that must be installed or added in to Excel
· Once added, it appears in the Analysis group on the Data tab as shown in Figure 
· Solver:
· an add-in program that searches for the best solution to a problem with several variables
· Used to find the best way to allocate resources 
· Requires three parameters:
· target cell typically contains a formula that is directly or indirectly based on the adjustable cells and constraints:
· Dependent Variables and Independent Variables need to be formulated appropriately
· adjustable cells are the cells whose values are adjusted until the constraints are satisfied 
· constraints specify the restrictions:
· Typically in the form of inequalities or equations
Overview of Linear Programming
Requirements of LP:
· LP problems seek to maximize or minimize some quantity (usually profit or cost) expressed as an objective function
· The presence of restrictions, or constraints, limits the degree to which we can pursue our objective
· There must be alternative courses of action to choose from
· The objective and constraints in linear programming problems must be expressed in terms of linear equations or inequalities
Decision Analysis Using Solver
· Define the problem
· Using identified input ranges, output cells, and constraints, Solver can minimize or maximize the input cell or set the output cell to a particular value 
· Define the parameters using the Solver dialog box
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